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The BRM Tool 

The BRM tool is a utility for backing up, restoring, and moving content for SAS 

Solutions Services, SAS Financial Management, SAS Strategy Management, and SAS 

Human Capital Management.  

Note: For historical reasons, some BRM filenames contain the word “migrate.” 

However, the BRM tool cannot be used to migrate from one version of SAS to another. 

What Is Backed Up, Restored, or Moved 

The BRM tool backs up, restores, or moves the following types of content:  

 all metadata content 

 all the DAV content that is managed by the SAS Content Server 

 the following MySQL databases (if applicable for the site's installed products): 

 HCM  

 SASOP  

 SASSDM  

 SHAREDSERVICES  

 SPM  

 secondary ODCS databases, if any  

 SAS Table Server databases, if any  

Note: We recommend that you configure the solutions to store the Shared Services 

database in MySQL, not in SAS Table Server. 

 the contents of the SAS-config-dir\Lev1\SASApp\Data and SAS-config-

dir\Lev1\AppData, and SAS-config-dir\Lev1\Data directories 

Note: SAS-config-dir\Lev1 is the directory specified by the BRM.config.dir 

property, and SASApp (or SASMain) is specified by the BRM.sasapp.dir property.  

Site customizers can extend the BRM tool to include additional directories and types 

of storage in BRM's backup targets. For more information about customizing BRM to 

add additional backup targets, search the brm.properties.template and customAnt.xml 
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files in the BRM-install-dir\config directory for the word “custom1”. Read the 

comments and examples that are near that keyword. 

Features 

The BRM tool has the following features: 

 coordinated backup on all server machines in a multi-tier installation  

 pausing of the Web application server while content is being backed up and 

restored, to preserve data integrity by preventing normal user access  

 support for automated nightly backups with minimal disruption to servers  

 ability to move content between operating system types (with limitations; see 

below)  

 ability to combine multiple tiers into one  

 ability to split one tier into multiple tiers 

Limitations 

General Limitations 

BRM 5.2 version 2 is supported on version 5.2 of SAS Solutions Services, SAS 

Financial Management, SAS Human Capital Management, and SAS Strategy 

Management (collectively referred to in this document as Solutions 5.2). With some 

limitations, BRM 5.2 version 2 can also be used for Solutions 5.1. 

The following limitations apply to BRM 5.2 version 2 (for both Solutions 5.2 and 

Solutions 5.1): 

 The BRM tool does not support partial promotion. It moves all solutions content, 

with no provision for selecting particular objects to move.  

 The source and destination systems must be at the same version level, running 

the same products. In this context, “products” refers not only to the solutions but 

also to other products such as SAS Web Report Studio.  

 The source and destination systems must have the same type of Shared Services 

database. If the Shared Services database is on MySQL on one system and on SAS 

Table Server in another system, then BRM cannot move content between those 

systems.  

 The SAS Trusted User (sastrust) must have the same account type on both the 

source and destination systems: either an internal account (metadata-based) or an 

external account (operating system-based). The same limitation applies to the SAS 

Solutions Administrator (slnadm). 

Limitations for Solutions 5.2 

For Solutions 5.2, the BRM tool can move content between installations with the 

following operating system and machine types:  

 32-bit Windows to 32-bit Windows  

 64-bit Windows to 64-bit Windows  

 32-Bit Windows to 64-bit Windows 
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 64-bit Linux to 64-bit Linux 

 AIX to AIX 

Moving content between Windows and UNIX installations is not currently supported. 

Limitations for Solutions 5.1 

For Solutions 5.1, BRM 5.2 version 2 supports moving content only between 

installations with the same operating system. For example, it can move content between 

two installations, both running 32-bit Windows Server 2003 or both running 64-bit 

Windows Server 2008.  

Migration Testing Note 

Migrating SAS solutions from one version to another after running BRM 5.2 version 2 

has not yet been tested. 

 

Conventions 

This book uses the following documentation conventions to identify paths in the 

solutions configuration: 

 

Path Refers to 

SAS-config-dir Path to the SAS configuration directory. For example: 

(Windows) C:\SAS\Config 

(UNIX) /usr/local/SAS/Config 

SASHOME Path to the SAS installation directory. For example:  

(Windows) C\Program Files\SAS 

(UNIX) /usr/local/SAS 

BRM-install-dir Path to the BRM installation directory. For example: 

(Windows) C:\SAS\BRM-install 

(UNIX) /usr/local/SAS/BRM-install 

 

The name of the configuration directory and the level number might be different at 

your site. 

Check for Updates to These Instructions 

For additions and updates to these instructions, see the README-FIRST.txt file, in 

the same directory as this document. 
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Unzip the Distribution File into Each BRM Installation Directory 

The distribution file is named BRM-5.2*.zip.  

On each server machine in the Solutions installation, unzip the distribution ZIP file into 

a new directory. This directory is the BRM installation directory.  

Keep the following points in mind:  

 You must install a copy of BRM locally on each computer on which it will run.  

A BRM installation directory cannot be shared between machines.  

There are configuration files in each installation directory that might have 

settings that are unique to a particular machine.  

In addition, the BRM agent that runs on each machine creates its own log file 

(named BRM-agent.log) in the installation directory.   

 On Windows, BRM does not support being run from a UNC network path.  

For example, you cannot run BRM with a command such as the following:  

\\machinename\share\BRM-install\brm backup 

It must be run from a regular disk path, like this:  

C:\SAS\BRM-install\brm backup 

Run the BRM Setup Script 

Perform these steps on every computer on which BRM is installed:  

1 Open a command window in the BRM installation directory.  

2 Run one of the following commands:  

 On Windows: 

setup SASHOME 

 (UNIX)  

. setup.sh SASHOME 

 

For SASHOME, substitute the full path to your main SAS installation directory. On 

Windows this is typically something like C:\Program Files\SAS. If there are spaces 

in SASHOME, enclose the path in quotation marks. For example:  

C H A P T E R  
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setup "C:\Program Files\SAS" 

On UNIX, you cannot run this command as ./setup.sh, because the file has just 

been unzipped from the BRM distribution zip file and still is not marked executable. 

When setup.sh runs, it marks all of the .sh files in the BRM installation directory as 

executable so that in the future, they can be run normally, like this: ./brm.sh. 

The setup script creates the brm.ini file from the brm.ini.template file. The setup 

script makes substitutions and modifications as necessary, based on the operating 

system platform and the SASHOME value that you provide.  

In the BRM-install-dir\config directory, the setup script also copies the 

brmagent.properties.template file to a file called brmagent.properties. It copies the brm-

log4j.properties file to a file called brm-log4j.properties.  

Edit the brm.properties File 

Perform these steps on the machine where the metadata server is installed. (This 

machine is referred to as the metadata tier in this document. At many sites, the 

metadata tier and the data tier are on the same machine.) You will run the BRM 

controller on this machine. The BRM controller reads the brm.properties file, and its 

properties are made available to the BRM agent on each machine.  

1 In the BRM-install-dir\config directory, make a copy of the 

brm.properties.template file. Name the new file brm.properties. 

2 Edit the brm.properties file with a text editor. 

3 Following the instructions in the file comments, set the BRM property values. 

This file is a Java properties file. Every line beginning with # is a comment. 

Comment lines and blank lines are ignored. The other lines define properties used 

by BRM.  

4 Save the file. 

Because the backslash character (\) has special meaning in Java properties files, the 

backslash characters in directory paths in this file must be doubled. For example, if your 

configuration directory is C:\SAS\Config\Lev1, then the corresponding setting in the 

properties file is: BRM.config.dir=C:\\SAS\\Config\\Lev1. 

Share the BRM Output Directory 

For a multi-tier installation, the BRM output directory (property BRM.output.dir) 

must be a shared directory that is accessible across the network from all machines in 

the solutions installation. The name of the BRM output directory must be in the form of 

a network directory, with a name relative to network share (such as 

\\mymachine\Public\backup) instead of relative to a local disk (such as 

C:\Public\backup).  

For example, imagine a solutions installation with two servers, machine1.default.com 

and machine2.default.com. Machine1 has the largest amount of free disk space 

available. If a directory C:\data\BRM-backup is chosen as the BRM output directory, 

and the C:\data directory is shared as \\machine1\data, then your brm.properties 

file should have this setting:  
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BRM.output.dir=\\\\machine1\\data\\BRM-backup 

Note: Each backslash in this line in the file is doubled, as required by the Java 

properties file format.  

Set the permissions on the shared directory so that the user who runs BRM has 

permission to write to \\machine1\data from both machine1 and machine2.  

Edit the brmagent.properties File 

The config\brmagent.properties file contains properties that are specific to the 

instance of the BRM agent on a particular machine. Property values that are set in this 

file override properties of the same name that are configured in the brm.properties file 

on the machine on which the BRM controller was run.  

If both of the following conditions are true, you do not need to modify the 

brmagent.properties files: 

 Your configuration directory path is exactly the same on every machine on which 

BRM is installed. 

 You plan to use the default BRM TCP port number of 2206. 

Otherwise, perform these steps on every computer on which BRM is installed.  

1 Edit the brmagent.properties file with a text editor.  

2 Following the instructions in the file comments, set the BRM property values. 

Like the brm.properties file, the brmagent.properties file is a Java properties file. 

The same general syntax rules apply. 

3 Save the file. 

Notes:  

 If the SAS configuration directory is different on this machine than on the 

machine on which the brm.properties file resides, you must set the 

BRM.config.dir property in the brmagent.properties file. Otherwise, that line 

can remain as a comment.  

 If you want BRM to use a different TCP port number than the default (2206), 

change the BRM.agent.port property in the brmagent.properties file. However, if you 

change this property in one of the brmagent.properties file, you must also change 

it in the brmagent.properties file on every other machine. The port number must 

be the same in every file.  

(Optional) Edit the brm-log4j.properties File 

BRM uses the Java Log4j logging component. The config\brm-log4j.properties file 

is the configuration file used by Log4j to control which log messages are recorded and to 

which file they are sent. There is a brm-log4j.properties file on every computer on which 

BRM is installed. 

The default settings in brm-log4j.properties are sufficient for most sites. Usually the 

only reason to edit the brm-log4j.properties file is to enable logging of debug level 

messages. See Enabling BRM Debug Logging on page 33 for more information.  

http://logging.apache.org/log4j/1.2/
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Notes:  

 The main BRM log file is named BRM.log. This file is placed in the current 

working directory in which the BRM controller is running.  

 Log messages from the backup and restore operations executed by the BRM 

agents on each machine are automatically collected in the central BRM.log file 

that is created by the BRM controller.  

 Each BRM agent instance also creates a BRM-agent.log file. This file normally 

contains only a few messages, for events such as the BRM agent starting and 

stopping.  

 The brm-log4j.properties file is in the Java properties file format.  
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BRM Controller and Agents 

The BRM tool can perform coordinated backup and restore operations on multiple 

machines. This coordination is achieved by running the BRM tool in controller mode on 

one machine and in agent mode on the other machines.  

If the solutions installation is on a single machine, then a separate BRM agent is not 

necessary.  

Starting the BRM Agent 

Note: You no longer need to run a separate BRM agent on the same machine as the 

controller. 

To run the BRM agent, open a command window in the BRM installation directory 

and run this command:  

 On Windows: 

brm agent [--allow-shutdown] 

 On UNIX: 

./brmrunas.sh sassrv agent [--allow-shutdown] 

On UNIX systems, use the brmrunas command. You are prompted for the sassrv 

password. During a brm restore, BRM must overwrite some files that are owned by 

the SAS Spawned Servers account (typically, sassrv). When necessary, BRM executes 

subcommands as sassrv in order to overwrite these files.  

When the BRM agent has started and is ready to accept requests, it prints a single 

line of output like this:  

12:16:15  INFO BRMAgent is listening for requests on port 2206 

Without the --allow-shutdown option, the BRM agent remains running on this 

computer until you shut it down by typing CTRL+C in the command window in which 

you started the agent. Do not shut down the BRM agent until all BRM operations are 

complete and no more BRM commands are to be issued. 

When the BRM agent is run with the --allow-shutdown option, each BRM agent 

exits after a BRM command completes. This option is helpful for running automated 

nightly backups. For example, assume that you scheduled brm backup to run at 3:00 

A.M. on the metadata server machine. Then you would schedule brm agent --allow-

shutdown to run at 2:55 A.M. (for example) on every other server machine in the 
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installation. After the BRM backup is complete, all the agents will shut down 

automatically. Without the --allow-shutdown option, the agents would still be 

waiting for further commands after the backup is complete. 

 

Running the BRM Controller 

The BRM controller is run automatically whenever a BRM command is initiated, such 

as brm backup or brm restore. For descriptions of these commands, see Backup and 

Restoration on the Same Machines on page 11.  
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Overview 

Use these instructions to back up solutions content and later restore that content on 

the same machine or set of machines.  

For instructions on moving solutions content to a different machine or set of 

machines, see Moving Solutions Content Between Machines on page 15. 

Creating a Backup 

To create a backup of solutions content, follow these steps:  

1 Leave all services and servers running.  

While BRM backs up the content, the metadata server and the Web applications 

servers are paused briefly. They resume again automatically before BRM finishes.  

2 Start the BRM agent on every machine except the metadata-tier machine (where 

you started the BRM controller). See Starting the BRM Agent on page 9. 

3 Set the BRM.output.dir property in the brm.properties file to determine where 

the solutions content is backed up.  

The BRM.output.dir directory must be a shared directory that is accessible from 

all the machines that are backed up. 

4 Open a command window in the BRM installation directory on the metadata-tier 

machine.  

5 Run the following command: 

 On Windows: 

brm backup 

 On UNIX: 

./brm.sh backup 
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Restoring from a Backup 

Follow these instructions to restore solutions content from a brm backup that was 

performed on the same machine or set of machines.  

Note: You must perform a brm restore using a backup that was made with the 

same version of BRM. You cannot use BRM 5.2 version 2 to restore from a backup that 

was made using BRM version 1.4.  

Follow these steps:  

1 Before running brm restore, make sure that all servers and services are 

running.  

BRM shuts down and restarts the metadata server. On the middle tier, it also 

shuts down the managed server for the portal (by default, SASServer1) and the 

managed server for the solutions (by default, SASServer3). All servers other than 

the metadata server need to be manually restarted after brm restore is 

completed.  

2 Start the BRM agent on every machine except the metadata-tier machine. See 

Starting the BRM Agent on page 9. 

3 Open a command window in the BRM installation directory on the metadata-tier 

machine.  

4 Run the following command:  

 On Windows: 

brm restore BRM-backup-directory 

 On UNIX: 

./brmrunas.sh sassrv restore BRM-backup-directory 

BRM-backup-directory is the name of the BRM output directory that was 

specified when the BRM backup was created.  

On UNIX, you are prompted for the password for the sassrv user. 

5 After running the restore command, a confirmation dialog will come up. Enter Y 

or Yes to proceed with the BRM restore. 

 If you do not see a dialog window come up, check to make sure it is not hidden 

behind some other window on your computer desktop. 

 On UNIX, if the DISPLAY environment variable is not set, then instead of 

displaying a graphical confirmation dialog, BRM will print a message to the 

console. In this case, enter Y or Yes in the command window in which you 

typed the restore command. 

 If it is necessary to disable the confirmation dialog, see Suppressing the BRM 

Restore Confirmation Dialog on p. 33. 

After the brm restore command is completed, follow these steps: 

1 Restart all the SAS servers and Web application servers, except the metadata 

server. The metadata server was automatically restarted by brm restore.  

2 (SAS Human Capital Management only) Rebuild the OLAP cubes, as described 

below. 
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Instructions for Rebuilding the OLAP Cubes 

To rebuild the OLAP cubes for SAS Human Capital Management: 

1 On the data tier, ensure that SAS Server Users have full control over the SAS-
config-dir\Lev1\Appdata\SASHumanCapitalManagement5.2\Cubes 

directory and its contents.  (These are file system permissions, not metadata 

permissions.) 

For more information, see “Secure Your Installation” in the SAS Solutions 

Services: System Administration Guide. 

2 Log on to SAS Human Capital Management as the SAS Demo User. This user 

must have the HCM Administrator role. 

3 Click Administration. 

4 On the Data tab, select Cubes. 

5 Click Refresh cubes. 

6 Select the check box at the top of the page to select all the cubes. 

7 Select both Rebuild selected cubes and Create Information Maps for 
selected cubes. 

8 Click OK. 
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Introduction 

These instructions are for using BRM to move solutions content from one machine or 

set of machines to another. 

Moving content via BRM includes these features:  

 Move solutions content from one solutions installation to another. This content 

includes all metadata, MySQL data, DAV content, and data sets in the 

configuration directory. 

 Combine content from a two-tier source installation into a one-tier destination 

installation.  

 Split one tier into multiple tiers. 

 Move content between a 32-bit Windows installation and a 64-bit Windows 

installation.  

Moving content via BRM has the following limitations: 

 No version upgrade is permitted. The solutions must be at the same version 

level on the source and destination systems.  

 The same products must be installed on the source and destination systems.  

 All content-related metadata and data are moved. There is no partial promotion 

ability.  

 The same set of users must exist in the destination system as in the source 

system. There is an exception: limited automatic remapping of the Windows 

domain prefix is performed. For details, see (If Necessary) Create an Operating 

System Account for sasadm on page 17. 

Overview of Moving Content 

Moving content between one Solutions installation and another requires these general 

steps. (Each step is described below in more detail.) 

1 Perform the required preparation.  

2 Run brm backup on the source installation.  

3 Run brm backup on the destination installation.  

4 Run brm saveconfig on the destination installation.  

5 Edit brm.properties and run brm restore on the destination installation, using 

the output directory from the BRM backup performed on the source installation.  

6 Update the logon names and passwords in the SAS Management Console. 

7 Run brm loadconfig.  

8 Run brm fixpaths to update the file and directory paths in metadata.   

9 Run brm fixhosts to update the machine names in metadata.  

10 Restart all servers.  
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Preparation for Moving Content 

(If Necessary) Create an Operating System Account for sasadm 

If the SAS Administrator (sasadm) has an operating system account in the source 

installation, a matching account must exist in the operating system of the destination 

installation. This is true even if sasadm is an internal account on the destination 

system.  

If an account is local to the metadata server machine, its domain prefix is 

automatically converted to the new metadata server machine name. Here is an example: 

 On the source installation:  

 the metadata server is named "machine1"  

 SAS Administrator has account machine1\sasadm  

 On the destination installation:  

 the metadata server is named "machine2"  

In this hypothetical example, when BRM moves the metadata from machine1 to 

machine2, the name of the account that is associated in metadata with user "SAS Demo 

User" is automatically converted from machine1\sasadm to machine2\sasadm. For 

authentication to succeed, you must create the machine2\sasadm account if it does not 

already exist.  

Run brm backup on the Source Installation 

On the source installation, follow the steps for Creating a Backup on page11, with the 

following additional step:  

If the source and destination installations have different operating systems (for 

example, 32-bit Windows versus 64-bit Windows), uncomment the following line in your 

brm.properties file:  

BRM.cross.platform=true 

Run brm backup on the Destination Installation 

On the destination installation, follow the steps above for Creating a Backup. 

Be sure to use different BRM output directories to back up content from the source 

and destination installations.  

The purpose of creating a BRM backup of the destination installation is to be able to 

roll back to the original content if there are issues with the content or the configuration 

that has been moved.  

Run brm saveconfig on the Destination Installation 

The brm saveconfig command saves configuration-related data and metadata in 

the temp directory under the BRM installation directory. This saved information is used 

later by the brm loadconfig command. 

On the metadata server machine, open a command window. Change to the BRM 

installation directory. Run the following command:  

 On Windows:  
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brm saveconfig 

 On UNIX:  

./brm.sh saveconfig 

Run brm restore on the Destination Installation 

On the destination installation, follow the steps in Restoring from a Backup on page 

12, with the following modifications:  

 When you edit the brm.properties file, modify accounts and passwords as 

necessary: 

Item Description of Change 

BRM.trusted.user and 

BRM.admin.user 

Modify these logon names to match the logon names for 

SAS Trusted User and SAS Administrator, 

respectively, on the source system. There is one 

exception: the domain name, if included, must match 

the destination system. 

For example, assume that “machine1” is the source 

metadata server and “machine2” is the destination 

metadata server. If the source system logon name is 

machine1\sasadm and the destination system logon 

name is sasadm@saspw, you would change the entry in 

the brm.properties file as follows: 

BRM.admin.user=machine2\\sasadm 

 

Internal accounts such as 

sasadm@saspw 

Enter the password from the source system. The 

metadata that is moved from the source system 

includes the passwords for these accounts. 

Operating system accounts Enter the password that matches the domain or 

machine on which they are validated in the destination 

installation. 

MySQL administrator 

account and WebLogic 

administrator account 

Leave these account passwords as they are on the 

destination system. These passwords do not come from 

metadata and are not changed by the BRM restoration  

process. 

Note: Do not modify the BRM.output.dir property. 

 When you run the brm restore command, specify the directory with the output 

from the brm backup command that you ran on the source installation. For 

example:  

 On Windows:  

brm restore \\machinename\sharename\BRM-backup-dir 

 On UNIX: (all on one command line) 

./brmrunas.sh sassrv restore 

/export/machinename/sharename/BRM-backup-dir 

Note: After the brm restore command completes, do not restart the servers. 

Complete the remaining steps below first.  

 

file:///C:/Olympia/doc/5.21/machine1/sasadm
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Steps to Take after Moving Content 

Introduction 

Running brm restore modifies user login and password metadata on the destination 

system so that it matches the values on the source system. After moving content to the 

destination system, you must synchronize the user logon and password information in 

the metadata server for key administrative accounts with the metadata logon 

credentials that are stored in various configuration files on the system.  

In the following sections, you use SAS Management Console and the SAS Deployment 

Manager to restore the user credentials to their original values on the destination 

system (that is, the values that they had before the move). 

All the tasks in this section occur on the destination system. Failure to make these 

changes results in services being unable to restart and SAS Data Integration Studio jobs 

being unable to run.  

Update User Credentials 

At this point, the user credentials on the destination system match the credentials on 

the source system. Restore those credentials to their original values, as follows: 

1 Log on to SAS Management Console as the SAS Administrator. 

The first time you log on to SAS Management Console, you must use the SAS 

Administrator logon name from the source system. If the source system has an 

internal account for SAS Administrator, you must use the password from the 

source system for this first logon session. 

2 On the Plug-ins tab, select User Manager. 

3 Right-click the SAS Administrator user and select Properties. 

4 Select the Accounts tab. 

5 Make the following changes, based on the current account type for this user and 

the original account type on the destination system: 
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Current Account Type Original 
Account Type 

Action 

Internal account (“Internal 

account” appears at the foot 

of the dialog box) 

Internal account Update the user ID and password to 

match the original values on the 

destination system. 
External account Delete the user ID and password. 

Click New to create an operating 

system-based account with user ID 

and password to match the original 

values on the destination system. 

External account (“Internal 

account” does not appear at 

the foot of the dialog box) 

Internal account Click Create Internal 

Account. Use the same user ID 

and password as the original values 

on the destination system. 
External account Edit the logon information so that 

the user ID and password match the 

original values on the destination 

system. 

 

6 Repeat steps 3-5 for the following users and group: 

 SAS Trusted User  

 SAS Demo User 

 SAS Solutions Administrator 

 Solutions Host User 

 SAS Anonymous Web User 

 SAS General Servers (group account) 

Update MySQL Credentials in Metadata 

Certain metadata groups contain logon information for accessing MySQL databases. 

The passwords for these logon accounts need to be restored to their original values on 

the destination system.  

Follow these steps: 

1 Log on to SAS Management Console as the SAS Administrator. 

2 On the Plug-ins tab, select User Manager. 

3 Right-click the SASSDM MySQL Users group and select Properties. 

4 Select the Accounts tab. 

5 Select the login row (for example, sassddbadm) and click Edit. 

6 Change the password to match the password for that MySQL account on the 

destination system. 

Repeat steps 3-6 for the following groups: 

 HCM MySQL Users (if SAS Human Capital Management is installed)  

 SPM MySQL Users (if SAS Strategy Management is installed)  
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Update the User Service Configuration 

The user service definitions in metadata for the SAS Administrator and SAS Trusted 

user accounts must be updated so that the SAS Remote Services start correctly.  

Follow these steps:  

1 Log on to SAS Management Console as the SAS Administrator. 

2 On the Plug-ins tab, navigate to Environment Management > Foundation 

Services Manager > Remote Services > Core > User Service. 

3 Right-click User Service and select Properties. 

4 On the Service Configuration tab, click Configuration. 

5 In the User Service Configuration dialog box, select the Users tab. 

6 For each item in the User IDs box, select the user ID and click Edit. 

Modify the ID and password to match the original ID and password on the 

destination system. Click OK. 

7 Navigate to Environment Management > Foundation Services Manager > 

SASBIDashboard4.3 Local Services > Core > User Service and repeat 

steps 3 through 6. (Substitute the appropriate version number if necessary.)  

8 If SAS Strategy Management is installed: Navigate to Environment 
Management > Foundation Services Manager > 

SASStrategyManagement5.2 Local Services > Core > User Service 

and repeat steps 3 through 6. (Substitute the appropriate version number if 

necessary.) 

Edit the brm.properties File 

Make the following changes in the brm.properties file: 

 Set BRM.admin.user to the current logon name of the SAS Administrator on the 

destination system.  

 Set BRM.admin.password to the password of the SAS Administrator on the 

destination system.  

Save the file.  

Run brm loadconfig 

The brm loadconfig command loads certain configuration items into the metadata 

repository—items that were extracted by the brm saveconfig command and saved in 

the temp directory under the BRM installation directory. It makes other important 

updates, such as updating the status.xml file so that upgrade in place is possible and 

loading some HCM configuration data back into the HCM database. 

To run brm loadconfig, follow these steps: 

1 Make sure that the BRM agent is running on all of the servers. 

2 On the metadata server machine, open a command window.  

3 Change to the BRM installation directory.  
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4 Run the following command:  

 On Windows:  

brm loadconfig 

 On UNIX:  

./brm.sh loadconfig 

The first time you run the brm loadconfig command you may see warning 

messages like the following: 

WARN Could not match 2 object(s) by name. 

WARN To ignore these warnings (not recommended), re-run with the force option: brm 

loadconfig force 

WARN Created new template file at: C:\BRM\config\loadconfig.ini 

WARN Edit this file and then re-run brm loadconfig to enable BRM to find the needed 

objects by name. 

INFO Aborted loading configuration objects. 

If you see this message: 

 Edit the loadconfig.ini file. 

 Follow the instructions in the loadconfig.ini file. 

 Save the file, then re-run brm loadconfig. 

Update File and Directory Paths in Metadata 

After you move metadata from one installation to another, you must usually change 

the file and directory paths in metadata to match the new environment. This task is 

necessary unless all the file and directory paths in the destination installation are the 

same as in the source installation. The match must include the configuration directories 

and the SAS installation directories on each tier.  

After brm loadconfig successfully completes, perform the following steps on the 

metadata server in the destination installation.  

Edit the migrate.ini File 

Perform these steps in the destination installation, on the machine where the 

metadata server resides: 
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1 In the BRM-install-dir\config directory, choose one of the 

migrate.ini.template-* files and copy it to migrate.ini in that same directory. Use 

this chart as a reference: 

Template File Examples of Intended Use  

migrate.ini.template-simple When the configuration directory name is the same 

on all machines in an installation, but different 

between the source systems and destination 

systems. 

When the destination system is a single-tier 

installation. 

migrate.ini.template-zzcomplex When the configuration directory name or 

SASHOME directory name is different on different 

machines within the destination installation; 

When data is spread over multiple disk drives.. 

If your situation does not meet the intended uses in the table above, we 

recommend that you begin with the migrate.ini.template-simple template and 

customize it to meet your needs. Use the migrate.ini.template-zzcomplex as a 

reference for the possible substitutions that can be made. However, that template 

is more complex than is necessary for most installations.  

2 Edit the migrate.ini file with a text editor.  

See the next two topics for information about editing the file. 

Explanation of the migrate.ini file 

The [file_and_directory_paths] section of the migrate.ini file contains a group 

of configuration lines with the following format:  

<source-path>=<destination-path> 

For example, you might have a line that looks like this:  

C:\SAS\SASSolutionsConfig\Lev1\Web=W:\SAS\Config\Lev1\Web 

The configuration line above instructs BRM to convert file and directory paths 

beginning with C:\SAS\SASSolutionsConfig\Lev1\Web to instead begin with 

W:\SAS\Config\Lev1\Web. If the directory path 

C:\SAS\SASSolutionsConfig\Lev1\Web\Logs is found in metadata, it is converted 

to W:\SAS\Config\Lev1\Web\Logs, according to the example migrate.ini line above.  

If two or more lines from migrate.ini match a path found in metadata, the line from 

migrate.ini with the longest left-hand path is used. For example, suppose these two lines 

exist in the [file_and_directory_paths] section of the migrate.ini file:  

C:\SAS\SASSolutionsConfig\Lev1\AppData= 

  D:\SAS\Configuration\Lev1\AppData 

C:\SAS\SASSolutionsConfig\Lev1\AppData\SASBIDashboard4.3= 

   W:\SAS\Config\Lev1\AppData\SASBIDashboard4.3 

If the path 

C:\SAS\SASSolutionsConfig\Lev1\AppData\SASBIDashboardEventGen4.3 is 

found in metadata, it matches the second line instead of the first line in the migrate.ini 

file, because the more specific match is used.  
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Changing the migrate.ini File to Meet Your Needs 

Starting with the migrate.ini file that you copied from the appropriate template (as 

explained in Edit the migrate.ini File on page 22), edit the paths to match your 

installation. Do not just accept the default values in the file. Check the drive letters and 

directory names on each line. The default assumes that you are changing drive letters, 

which may not be the case for your installation. 

If you copied your migrate.ini file from migrate.ini.template-single, make the 

following changes: 

1 Fix the line for the configuration directory: 

<source-path>=<destination-path> 

 Change the path to the left of the equal sign to the name of your source 

configuration directory.  

 Change the path to the right of the equal sign to the name of your destination 

configuration directory. 

2 Make similar changes to the line for the SASHOME directory and to any other 

applicable lines in the file.  

If you copied your migrate.ini file from migrate.ini.template-zzcomplex, make 

changes as for the single-tier example in the paragraph above. However, there are 

many more lines in the multi-tier migrate.ini template file, with directory name 

matching that is more specific. This permits better distinction between paths on 

the data-tier machine and paths on the middle-tier machine. A search and replace 

of directory name prefixes might be appropriate, but check the results carefully.  

3 Save the file when the changes are complete.  
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Run brm dumppaths 

Run the brm dumppaths command to get a listing of all the known file and directory 

paths current in metadata. The last parameter on the command line directs the output 

to a text file named dump1.txt:  

 On Windows:  

brm dumppaths dump1.txt 

 On UNIX:  

./brm.sh dumppaths dump1.txt 

Run brm fixpaths 

Run the brm fixpaths command to change the file and directory paths in metadata 

according to the configuration in the migrate.ini file.  

We recommend that you run the brm fixpaths command twice: 

 Run it the first time to log all the potential changes that would be made to 

metadata in the BRM.log file, without actually making any changes:  

 On Windows:  

brm fixpaths nochange 

 On UNIX:  

./brm.sh fixpaths nochange 

 

 After reviewing the BRM.log file, run the command again to make the actual 

changes to metadata:  

 On Windows:  

brm fixpaths commit 

 On UNIX:  

./brm.sh fixpaths commit 

Run brm dumppaths after Changing Metadata 

Run the brm dumppaths command again to see the complete effects of the brm 

fixpaths command. The last parameter on the command line directs the output to a 

text file named dump2.txt:  

 On Windows:  

brm dumppaths dump2.txt 

 On UNIX:  

./brm.sh dumppaths dump2.txt 

Compare and Rerun as Needed 

Compare the result of the first run of brm dumppaths with the result of running 

brm dumppaths after brm fixpaths was completed.  

For example, if the output of the first and second runs of brm dumppaths was placed 

in files dump1.txt and dump2.txt, respectively, then you would compare dump1.txt and 

dump2.txt and verify the changes that were made to the file and directory paths in 

metadata.  
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For this purpose, it is helpful to use a file comparison program. There are several free 

and commercial text-file comparison programs available. On UNIX, the diff program 

can be used. 

If important file or directory paths were not detected and changed, make additions to 

the migrate.ini file to match these paths. Then rerun the BRM fixpaths command.  

Update Machine Names in Metadata 

Edit the migrate.ini File for Host Name Change 

If you have not done so already, pick one of the migrate.ini.template files in the BRM 

config directory. Make a copy and name the new file migrate.ini.  

Edit the [domain_names] section of the migrate.ini file. This section is for changing 

Windows logon domains when you are moving content to another server. For example, to 

convert all logon IDs from DOMAIN1\username to DOMAIN2\username, and convert 

DOMAIN3\username to DOMAIN4\username, edit the [domain_names] section of the 

migrate.ini file to resemble the following:  

[domain_names] 

DOMAIN1=DOMAIN2 

DOMAIN3=DOMAIN4 

Check the Host Names in the brm.properties File 

If you have not already done so, edit the brm.properties  file and verify that the host 

names in the file are correct.  

Search the file for all occurrences of properties whose names begin with BRM.host 

and verify that the property value is correct. For a single-tier installation, all of these 

property values are set to the same machine name.  

These property values are used by the brm fixhosts command to update host 

names in metadata.  

Run the brm fixhosts Command 

The brm fixhosts command searches for host names in metadata and updates them 

according to the settings in your brm.properties file. BRM also consults the 

components.ini file, but the components.ini file normally is not altered by users.  

1 To preview the changes that brm fixhosts will make, without actually altering 

metadata, run the following two commands first:  

 On Windows:  

brm dumphosts hosts-before.txt 

brm fixhosts nochange 

 On UNIX:  

./brm.sh dumphosts hosts-before.txt 

./brm.sh fixhosts nochange 
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The brm dumphosts command writes a list of all host names that it found in 

metadata into a text file. These are the objects in metadata that potentially could 

be modified. Running brm fixhosts with the nochange option causes BRM to do 

everything that the fixhosts command normally does, short of changing 

metadata. Examine the messages in the BRM.log file to see the effects of the 

command.  

2 To update the metadata, run the following command in a command window on the 

machine running the metadata server:  

 On Windows:  

brm fixhosts commit 

On UNIX:  

./brm.sh fixhosts commit 

3 To see the new host names in metadata, run this command:  

 On Windows:  

brm dumphosts hosts-after.txt 

 On UNIX:  

./brm.sh dumphosts hosts-after.txt 

Examine the hosts-after.txt file.  

 

Update the HCMConfig.xml file (SAS Human Capital Management) 

The HCMConfig.xml file has configuration settings needed by SAS Human Capital 

Management. The HCMConfig.xml file on the destination system must be edited and 

certain values in it must be updated to match what is in the HCMConfig.xml file on the 

source system. 

The HCMConfig.xml file from the source system is located under the BRM output 

directory, in the following sub-directory: 

 On Windows: 

config\middle-tier-machine\SASHumanCapitalManagement5.2 

 On UNIX: 

config/middle-tier-machine/SASHumanCapitalManagement5.2 

For middle-tier-machine, substitute the name of the middle-tier machine in the source 

system. 

The HCMConfig.xml file for the destination system is located on the middle-tier 

machine, in the following directory: 

 On Windows: 

SAS-config-dir\Lev1\AppData\SASHumanCapitalManagement5.2 

 On UNIX: 

SAS-config-dir/Lev1/AppData/SASHumanCapitalManagement5.2 

Back up the HCMConfig.xml file on the destination system before making any 

changes. 

We suggest that you open the HCMConfig.xml files from the source and destination 

systems in two text editor windows, so that you can easily copy values from the source to 

the destination version of these files. 
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Note: We do not recommend using Notepad to edit the HCMConfig.xml file. If you use 

WordPad, select View > Options. On the Text tab, select No wrap in order to better 

manipulate the text in this XML-format file. 

1 In the destination HCMConfig.xml file, search for the text "site defined 

properties". 

2 Change the following Property element in the destination HCMConfig.xml file to 

match the source HCMConfig.xml file: 

<Property Id="HCM_HOME_DASHBOARD" Name="HCM_HOME_DASHBOARD" 

Value="/Users/sasdemo/HCM_DASHBOARD.dcx" ReadOnly="false"/> 

Update only the text in the quotation marks after Value=. (The text above is only 

an example). Be careful not to modify the quotation marks or any other text. 

3 Save the destination HCMConfig.xml file. 

Restart All Servers after Moving Content 

Follow these steps after all the steps above are completed:  

1 Restart all the servers, both SAS servers and Web application servers, except the 

metadata server.  

The metadata server was automatically restarted by brm restore.  

2 (SAS Human Capital Management only) Rebuild the OLAP cubes.  

For instructions, see Instructions for Rebuilding the OLAP Cubes on page 13. 

Refresh SAS Strategy Management Diagrams 

After you move content to a new server, SAS Strategy Management diagrams contain 

embedded URLs that reference the old server. To correct the URLs, give each user the 

following instructions for clearing the diagram cache: 

1 In an open project, select Project > Options. 

2 Expand the Diagram Options section. 

3 Click Clear Diagram Cache.  

This step clears the cache of temporary diagrams for all projects that the user has 

viewed. 

Alternatively, an administrator can refresh the diagrams in each scorecard project, as 

follows: 

1 Log on to the portal as a user with membership in the Solutions Users group, the 

SPM Users group, and the Scorecard Modeler Group.  

2 Open the scorecard project. 

3 Open a diagram in the Diagram Editor. 

4 Click the Refresh button on the right side of the SAS Strategy Management 

toolbar. 
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Note: if the diagrams are available in a Performance Diagram portlet, you can 

click the Refresh Data button  at the bottom of the portlet instead of using 

the Diagram Editor. 

Refresh SAS BI Web Services 

After you move content to a new server, SAS BI Web Services contain embedded 

metadata IDs that are incompatible with the metadata that has been moved. Each Web 

service must be exported, deleted, and then re-imported in order to function properly. 

To refresh the SAS BI Web Services, follow these steps: 

1 Log on to SAS Management Console as the SAS Administrator. 

2 On the Folders tab, navigate to SAS Folders/System/Services . 

3 In the right-hand pane, right-click the Corr Web service object and select Export 

SAS Package. 

The Export SAS Package wizard is displayed. 

4 Under Specify a package to contain the collection of objects 

that you are exporting, change the file name from Package1.spk to Corr.spk, 

to match the name of the Web service that will be exported. Click Next. 

5 Accept the defaults by clicking Next on the next two pages of the wizard. Then 

click Finish. 

6 Right-click the Corr Web service again and select Delete.  

7 In the left-hand pane, right-click the Services folder and select Import SAS 

Package. 

The Import SAS Package wizard is displayed. 

8 Under Enter the location of the input SAS package file, enter the 

path to the Corr.spk file from step 4, if it is not already there by default. Click 

Next. 

9 Accept the defaults by clicking Next on the next four pages of the wizard. Then 

click Finish. 

10 Repeat steps 1 through 9 for the remaining Web services in the Services folder. 

 

Update the URLs in BI Dashboard Indicator Files 

Overview 

After you move content to a new server, SAS BI Dashboard indicators that are based 

on SAS Strategy Management providers contain URLs with incorrect hostnames. As a 

result, BI Dashboard portlets that are based on SAS Strategy Management providers 

cannot be displayed properly. You must edit the indicator files to correct the host name 

in the URLs. 
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BI Dashboard 4.3 

For BI Dashboard 4.3, follow these steps: 

1 To list all of the providers of BI Dashboard indicator data, open a command 

window on the metadata-tier machine and run the following command: 

  On Windows: 

 brm indicators 

 On UNIX: 

./brm.sh indicators 

This command prints the metadata path for each BI Dashboard provider (.imx 

file). 

2 Log on to SAS Management Console as the SAS Administrator. 

3 On the Folders tab, navigate to a folder in which a BI Dashboard provider was 

saved. 

4 In the right-hand pane, right-click the .imx file and select Write Contents to 

External File. 

5 Complete the target file dialog. Save the destination file with the same name that 

is used in SAS Management Console. 

6 Using Windows Explorer or some other means, navigate to the directory in which 

the file was saved. Open the .imx file for editing. 

Note: We do not recommend using Notepad to edit the .imx files. If you use 

WordPad, select View > Options. On the Text tab, select No wrap in order to 

better manipulate the text in this XML-format file. 

7 In the .imx file, search for URL text that resembles the following: 

authenticationServiceURL=”http://default.host.com:7201/SASStrat

egyManagement” 

The host name is typically the name of the SAS Strategy Management server for 

the source system. 

If the file does not contain the keyword authenticationServiceURL, proceed to 

step 11. 

Otherwise, replace the host name with the name of the SAS Strategy Management 

server for the destination system. Update the port number if necessary. Be careful 

not to accidentally remove a quotation mark or change any other part of the URL. 

8 Save the file. 

9 In SAS Management Console, right-click the folder in which the BI Dashboard 

indicator was located and select Add Content From External File(s) or 

Directories. 

10 In the Specify Source File(s) or Directories dialog box, select Files of type: 

Dashboard types.  

Browse to the .imx file and click Open. Replace the original file in the metadata 

folder. 

11 Repeat steps 2 through 10 for each of the BI Dashboard indicators that contain 

SAS Strategy Management Providers. 

http://default.host.com:7201/SASStrategyManagement
http://default.host.com:7201/SASStrategyManagement
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BI Dashboard 4.2 

For BI Dashboard 4.2, follow these steps: 

1 To list all of the providers of BI Dashboard indicator data, open a command 

window on the metadata-tier machine and run the following command: 

  On Windows: 

 brm indicators 

 On UNIX: 

./brm.sh indicators 

This command prints the file path for each BI Dashboard provider (.imx file). 

2 Using Windows Explorer or some other means, navigate to the directory 

containing the first .imx file listed by the "brm indicators" command.  

Open this file with a text editor. 

Note: We do not recommend using Notepad to edit the .imx files. If you use 

WordPad, select View > Options. On the Text tab, select No wrap in order to 

better manipulate the text in this XML-format file. 

3 In the .imx file, search for URL text that resembles the following: 

authenticationServiceURL="http://default.host.com:7201/SASStrat

egyManagement" 

The host name is typically the name of the SAS Strategy Management server for 

the source system. 

If the file does not contain the keyword authenticationServiceURL, proceed to 

step 5. 

Otherwise, replace the host name with the name of the SAS Strategy Management 

server for the destination system. Update the port number if necessary. Be careful 

not to accidentally remove a quotation mark or change any other part of the URL. 

4 Save the file. 

5 Repeat steps 2 through 4 for each BI Dashboard provider. 

Restart SAS Remote Services and Web Application Servers 

Follow these steps after all of the steps above are completed:  

1 Restart SAS Remote Services. 

2 Restart the Web application servers. 

No other servers need to be restarted. After these steps are completed, the destination 

system is ready for use. 
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Reconfigure Client Machines 

After moving content, you must reconfigure the client machines, as follows: 

1 On each client machine, delete the SAS configuration directory. 

2 Rerun the SAS Deployment Wizard. Select Configure SAS Software as the 

deployment type, but do not select Install SAS Software. 
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Enabling BRM Debug Logging 

To enable debug output in the BRM log: 

1 Edit the brm-log4j.properties file in the BRM-install-dir\config directory.  

2 In the following lines, change the word info to debug:  

log4j.logger.com.sas.solutions.brm.migrate.MainMigrator=info, file  

log4j.logger.agentAnt=info, file  

3 Save the file.  

The next time that the brm backup, brm restore, or brm fixpaths command is 

run, significantly more output is placed in the BRM log file.  

Suppressing the BRM Restore Confirmation Dialog 

After running the brm restore command, BRM will display a confirmation dialog and 

wait for the user to enter Y or Yes to continue. (Or, on UNIX with no DISPLAY 

environment variable set, it will print a message and wait for keyboard input.) 

Sometimes it is desired to suppress this confirmation dialog. For example, this could be 

useful when running brm restore as one of several commands in a batch script, or in 

other situations where pausing for user input is not desired. 

Note: Suppressing the BRM Restore confirmation dialog should be done with care.  

The brm restore command will overwrite all solutions data with data from the 

indicated BRM backup directory. The purpose of the confirmation dialog is to give the 

user a chance to cancel the operation if it was initiated by mistake. 

To suppress the BRM Restore confirmation dialog, add the option 

-DBRM.skip.restore.prompt=1 after the "restore" keyword. For example: 

On Windows: 

    brm restore -DBRM.skip.restore.prompt=1 BRM-backup-directory 

On UNIX: 

    ./brmrunas.sh sassrv restore -DBRM.skip.restore.prompt=1 BRM-

backup-directory 

C H A P T E R  
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Troubleshooting 

Unexpected Debug Messages in BRM.log 

You turn on debug logging and see several messages like this:  

2010-08-17 20:12:09,877 DEBUG [misfmddev1[agent]] agentAnt - Could not 

load definitions from resource org/apache/tools/ant/antlib.xml. It could 

not be found. 

This message is generated by Ant and does not indicate a BRM problem. It might be a 

minor defect in Ant, but it causes no damage.  

Nothing Happens When Running BRM Command 

When you run a BRM command, such as brm backup, nothing happens and nothing 

is printed in the command window.  

This is most likely due to a problem with your brm.ini file, which is in the same 

directory as your brm.exe file.  

Edit your brm.ini file. Make sure that the MASTERPROP property value is set according 

to the instructions. If this property does not point to the correct file, then brm.exe cannot 

run.  

If that does not fix the problem, check the log messages in the Bootstrap.log file. The 

location of the Bootstrap.log file depends on your operating system:  

 

Platform Bootstrap.log Location 

Windows XP "%USERPROFILE%\Local Settings\Application 

Data\SAS\SASDeploymentWizard\9.2" 

Windows Vista, 

Windows 7, or 

Windows 2008 

Server 

"%USERPROFILE%\AppData\Local\SAS\ 

  SASDeploymentWizard\9.2" 

UNIX $HOME/.SASAppData/SASDeploymentWizard/9.2 

 

Error During BRM Backup: Multiple Master Servers in 
SAS_ODCS_SERVER Table 

When you run the brm backup command, you get an error like the following: 

 

2011-02-16 17:30:52,853  WARN [d20491.na.sas.com[mysql]] agentAnt - There 

are 2 rows in the SAS_ODCS_SERVER table with SERVER_TYPE=1 

2011-02-16 17:30:52,853 ERROR [d20491.na.sas.com[mysql]] agentAnt - 

Cannot back up SASSDM database: Found 2 ODCS Master servers, expected 1 

This problem appears when brm backup is run on the destination system and there 

is an invalid entry in the SAS_ODCS_SERVER table. 

The problem is caused when the name of the ODCS master server is changed and the 

server is restarted. At startup time, the server adds a row to the SAS_ODCS_SERVER 
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with the new server name. However, this new row is invalid because it is not linked to 

the existing data and because only one master server entry should exist in the 

SAS_ODCS_SERVER table at a time. For brm backup to work correctly, you must 

clean up the SAS_ODCS_SERVER table on the source system and run brm backup 

again. 

To clean up the SAS_ODCS_SERVER table, use any MySQL administrative tool to 

connect to the sassdm database on the source system.  The examples below use the 

MySQL command-line tool. Adapt these commands for the MySQL administrative tool 

that you are using. 

1 Query the rows in the SAS_ODCS_SERVER table. For example: 

mysql> select * from sas_odcs_server; 

+-----------+----------------------------+---------------------+-------------+-------------+ 

| SERVER_ID | SERVER_CD                  | SERVER_HOSTNAME     | SERVER_PORT | SERVER_TYPE | 

+-----------+----------------------------+---------------------+-------------+-------------+ 

|         8 | server5.example.com_MASTER | server2.example.com |        7301 |           1 | 

|        10 | server2.example.com_MASTER | server2.example.com |        9814 |           1 | 

+-----------+----------------------------+---------------------+-------------+-------------+ 

 

Rows with SERVER_TYPE=1 are master servers. There should only be one master 

server row at a time in the database. The example above shows a case with two master 

servers.  

2 Find out which of the master server rows has a SERVER_ID that is linked with 

the SAS_OP_FORM or SAS_VCUBE table. To do so, query these tables for the 

number of rows with SERVER_ID equal to the values found in the 

SAS_ODCS_SERVER table. (On some installations, the SAS_OP_FORM table 

might not have any entries.) 

For example, with SERVER_ID values of 8 and 10, you would use the following 

commands: 

mysql> select count(*) from SAS_OP_FORM where SERVER_ID=8; 

+----------+ 

| count(*) | 

+----------+ 

|     6613 | 

+----------+ 

1 row in set (0.02 sec) 

 

mysql> select count(*) from SAS_OP_FORM where SERVER_ID=10; 

+----------+ 

| count(*) | 

+----------+ 

|        0 | 

+----------+ 

1 row in set (0.02 sec) 

 

mysql> select count(*) from SAS_VCUBE where SERVER_ID=8; 

+----------+ 

| count(*) | 

+----------+ 
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|        4 | 

+----------+ 

1 row in set (0.00 sec) 

 

mysql> select count(*) from SAS_VCUBE where SERVER_ID=10; 

+----------+ 

| count(*) | 

+----------+ 

|        0 | 

+----------+ 

1 row in set (0.00 sec) 

 

Note: Be sure to run these queries and updates on the source system, not the 

destination system. 

3 From the results of these queries, determine which row to keep and which row to 

delete. 

In this example, the results show that a SERVER_ID of 8 is linked with multiple 

rows in the SAS_OP_FORM table and the SAS_VCUBE table, whereas a 

SERVER_ID of 10 does not appear in either of those tables. Therefore, the row 

with SERVER_ID=8 is the row to keep. (In your own queries, substitute the actual 

SERVER_ID values from rows in your SAS_ODCS_SERVER table with 

SERVER_TYPE=1.)  

If both server IDs are associated with data, do not delete any rows from the 

SAS_ODCS_SERVER table. Instead, consult with SAS Technical Support for 

instructions on how to resolve this issue. 

If the SERVER_ID values in SAS_OP_FORM and SAS_VCUBE are zero, and do 

not match any SERVER_ID values in SAS_ODCS_SERVER, then keep the row in 

SAS_ODCS_SERVER with SERVER_ID=1 and SERVER_TYPE=1, deleting any 

additional rows with SERVER_TYPE=1 that do not have SERVER_ID=1. 

4 In the SAS_ODCS_SERVER  table, update the row you want to keep, as follows:  

 If the SERVER_HOSTNAME field does not match the primary ODCS server 

name on the destination system, update that field with the correct value. 

 If necessary, make a similar change to the SERVER_PORT field. 

Note: The SERVER_CD field is ignored by the software. 

5 In the SAS_ODCS_SERVER table, delete the row with a SERVER_ID that is  not 

linked with the SAS_OP_FORM and SAS_VCUBE tables, as described above. 

When you have completed these updates to the SASSDM database on the source 

system, run brm backup again on the source system.  

 

 


